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Microsoft Excel 2007 and Tools
for Statistical Analysis
David R. Anderson, Dennis J. Sweeney,
and Thomas A. Williams

Microsoft Excel 2007, part of the Microsoft Office 2007 system, is a spreadsheet program
that can be used to organize and analyze data, perform complex calculations, and create
a wide variety of graphical displays. We assume readers of this primer are familiar with
basic Excel operations such as selecting cells, entering formulas, copying, and so on. But,
we do not assume readers are familiar with Excel 2007 or the use of Excel for statistical
analysis.
The purpose of this primer is twofold. First, we provide an overview of Excel 2007 and
discuss the basic operations needed to work with Excel 2007 workbooks and worksheets.
Second, we provide an overview of the tools that are available for conducting statistical
analysis with Excel. These include Excel functions and formulas which allow users to conduct their own analyses and add-ins that provide more comprehensive analysis tools.
Excel’s Data Analysis add-in, included with the basic Excel system, is a valuable tool
for conducting statistical analysis. In the last section of this primer we provide instructions
for installing the Data Analysis add-in. Other add-ins have been developed by outside suppliers to supplement the basic statistical capabilities provided by Excel. In the last section
we also discuss two commercially available add-ins developed by Palisade Corporation:
StatTools and PrecisionTree.

OVERVIEW OF MICROSOFT EXCEL 2007

A workbook is a file
containing one or more
worksheets.

When using Excel for statistical analysis, data is displayed in workbooks, each of which
contains a series of worksheets that typically include the original data as well as any resulting analyses, including charts. Figure 1 shows the layout of a blank workbook created
each time Excel is opened. The workbook is named Book1, and consists of three worksheets
named Sheet1, Sheet2, and Sheet3. Excel highlights the worksheet currently displayed
(Sheet1) by setting the name on the worksheet tab in bold. To select a different worksheet
simply click on the corresponding tab. Note that cell A1 is initially selected.
The wide bar located across the top of the workbook is referred to as the Ribbon. Tabs,
located at the top of the Ribbon, provide quick access to groups of related commands. There
are eight tabs: Home; Insert; Page Layout; Formulas; Data; Review; View, and Add-Ins.
Each tab contains a series of groups of related commands. Note that the Home tab is selected when Excel is opened. Figure 2 displays a portion of the Home tab. Under the Home
tab there are seven groups of related commands: Clipboard; Font; Alignment; Number;
Styles; Cells; and Editing. Commands are arranged within each group. For example, to
change selected text to boldface, click the Home tab and click the Bold button in the Font
group.
Figure 3 illustrates the location of the Office Button, the Quick Access Toolbar, and the
Formula Bar. When you click the Office Button, Excel provides a list of workbook options
such as opening, saving, and printing (worksheets). The Quick Access Toolbar allows you
to quickly access these workbook options. For instance, the Quick Access Toolbar shown
in Figure 3 includes an Open button
that can be used to open files without having to
first click the Office Button. To add or remove features on the Quick Access Toolbar click
the Customize Quick Access Toolbar button on the Quick Access Toolbar.
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FIGURE 1 BLANK WORKBOOK CREATED WHEN EXCEL IS OPENED
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The Formula Bar contains a Name box, the Insert Function button , and a Formula
box. In Figure 3, “A1” appears in the Name box because cell A1 is selected. You can select
any other cell in the worksheet by using the mouse to move the cursor to another cell and
clicking or by typing the new cell location in the name box. The Formula box is used to display the formula in the currently selected cell. For instance, if you had entered A1A2
into cell A3, whenever you select cell A3 the formula A1A2 will be shown in the
Formula box. This feature makes it very easy to see and edit a formula in a particular cell.
The Insert Function button allows you to quickly access all of the functions available in
Excel. Later we show how to find and use a particular function.
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FIGURE 2

PORTION OF THE HOME TAB
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FIGURE 3 EXCEL 2007 OFFICE BUTTON, QUICK ACCESS TOOLBAR,
AND FORMULA BAR

Office
Button

Formula
Bar

Quick Access
Toolbar

Name
Box

Click Button to Customize
Quick Access Toolbar

Insert
Function Button

Formula
Box

ASW_MBS_Primer_Web.qxd

4

11/1/07

1:41 PM

Page 4

Microsoft Excel 2007 and Tools for Statistical Analysis

FIGURE 4 WORKSHEET OPTIONS OBTAINED AFTER RIGHT CLICKING
ON A WORKSHEET TAB

Basic Workbook Operations
Figure 4 illustrates the worksheet options that can be performed after right clicking on
a worksheet tab. For instance, to change the name of the current worksheet from “Sheet1”
to “Data,” right click the worksheet tab named “Sheet1” and select the Rename option. The
current worksheet name (Sheet1) will be highlighted. Then, simply type the new name
(Data) and press the Enter key to rename the worksheet.
Suppose that you wanted to create a copy of “Sheet1.” After right clicking the tab
named “Sheet1,” select the Move or Copy option. When the Move or Copy dialog box appears, select Create a Copy and click OK. The name of the copied worksheet will appear as
“Sheet1 (2).” You can then rename it, if desired.
To add a worksheet to the workbook, right click any worksheet tab and select the Insert
option; when the Insert dialog box appears, select Worksheet and click OK. An additional
blank worksheet titled “Sheet 4” will appear in the workbook. You can also insert a new
worksheet by clicking the Insert Worksheet tab button
that appears to the right of the
last worksheet tab displayed. Worksheets can be deleted by right clicking the worksheet tab
and choosing Delete. After clicking Delete, a window will appear warning you that any data
appearing in the worksheet will be lost. Click Delete to confirm that you do want to delete
the worksheet. Worksheets can also be moved to other workbooks or a different position in
the current workbook by using the Move or Copy option.

Creating, Saving, and Opening Files
Data can be entered into an Excel worksheet by manually entering the data into the worksheet or by opening another workbook that already contains the data. As an illustration of
manually entering, saving, and opening a file we will use an example from Chapter 2 of the
Anderson, Sweeney, and Williams statistics texts involving data for a sample of 50 soft
drink purchases. The original data are shown in Table 1.
Suppose you have just opened Excel and want to work with this data. A blank workbook
containing three worksheets will be displayed. The soft drink data can now be entered manually by simply typing it into one of the worksheets. If Excel is currently running and no
blank workbook is displayed, you can create a blank workbook using the following steps:
Step 1: Click the Office button
Step 2: Click New in the list of options
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TABLE 1

DATA FROM A SAMPLE OF 50 SOFT DRINK PURCHASES
Coke Classic
Diet Coke
Pepsi
Diet Coke
Coke Classic
Coke Classic
Dr. Pepper
Diet Coke
Pepsi
Pepsi
Coke Classic
Dr. Pepper
Sprite
Coke Classic
Diet Coke
Coke Classic
Coke Classic

Sprite
Coke Classic
Diet Coke
Coke Classic
Diet Coke
Coke Classic
Sprite
Pepsi
Coke Classic
Coke Classic
Coke Classic
Pepsi
Coke Classic
Sprite
Dr. Pepper
Pepsi
Diet Coke

Pepsi
Coke Classic
Coke Classic
Coke Classic
Pepsi
Dr. Pepper
Coke Classic
Diet Coke
Pepsi
Pepsi
Pepsi
Pepsi
Coke Classic
Dr. Pepper
Pepsi
Sprite

Step 3: When the New Workbook dialog box appears:
Select Blank and recent under Templates
Double click Blank Workbook
A new workbook containing three worksheets labeled Sheet1, Sheet2, and Sheet3 will
appear.
Suppose we want to enter the data for the sample of 50 soft drink purchases into Sheet1
of the new workbook. First, we enter the label “Brand Purchased” into cell A1; then, we
enter the data for the 50 soft drink purchases into cells A2:A51. As a reminder that this
worksheet contains the data, we will change the name of the worksheet from “Sheet1” to
“Data” using the procedure described previously. Figure 5 shows the data worksheet we
have just developed.
Before doing any analysis with these data, we recommend that you first save the file;
this will save you from having to reenter the data in case something happens that causes
Excel to close. To save the workbook using the filename SoftDrink we perform the
following steps:
Keyboard shortcut: To save
the file, press CTRLS

Step 1: Click the Office button
Step 2: Click Save As in the list of options
Step 3: When the Save As dialog box appears:
In the Save in box select the location where you want to save the file
Type the filename SoftDrink in the File name box
Click Save
Excel’s Save command is designed to save the file as an Excel 2007 workbook. As you work
with the file to do statistical analysis you should follow the practice of periodically saving
the file so you will not lose any statistical analysis you may have performed. Simply follow the procedure described above using the Save command.
Sometimes you may want to create a copy of an existing file. For instance, suppose you
would like to save the soft drink data and any resulting statistical analysis in a new file
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FIGURE 5 WORKSHEET CONTAINING THE SOFT DRINK DATA
A
1
2
3
4
5
6
7
8
9
10
11
12
13
14
15
16
17
18
19
20
50
51
52
53
54
55

B

C

D

E

F

Brand Purchased
Coke Classic
Diet Coke
Pepsi
Diet Coke
Coke Classic
Coke Classic
Dr. Pepper
Diet Coke
Pepsi
Pepsi
Coke Classic
Dr. Pepper
Sprite
Coke Classic
Diet Coke
Coke Classic
Coke Classic
Sprite
Coke Classic
Pepsi
Sprite

Note: Rows 21–49 are hidden.

named “SoftDrink Analysis.” The following steps show how to create a copy of the SoftDrink workbook and analysis with the new filename, SoftDrink Analysis.
Step 1:
Step 2:
Step 3:
Step 4:

Click the Office button
Position the mouse pointer over Save As
Click Excel Workbook from the list of options
When the Save As dialog box appears:
In the Save in box select the location where you want to save the file
Type the filename SoftDrink Analysis in the File name box
Click Save

Once the workbook has been saved, you can continue to work with the data to perform
whatever type of statistical analysis is appropriate. When you are finished working with
the file simply click the close window button
located at the top right-hand corner of the
Ribbon. To access the SoftDrink Analysis file at another point in time you can open the file
by performing the following steps:
Step 1: Click the Office button
Step 2: Click Open in the list of options
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Step 3: When the Open dialog box appears:
In the Look in box select the location where you previously saved the file
Enter the filename SoftDrink in the File name box
Click Open
The procedures we showed for saving or opening a workbook begin by clicking on the
Office Button to access the Save and Open commands. Once you have used Excel for
awhile you will probably find it more convenient to add these commands to the Quick
Access Toolbar.

USING EXCEL FUNCTIONS
Excel 2007 provides a wealth of functions for data management and statistical analysis. If
we know what function is needed, and how to use it, we can simply enter the function into
the appropriate worksheet cell. However, if we are not sure what functions are available
to accomplish a task or are not sure how to use a particular function, Excel can provide
assistance.

Finding the Right Excel Function
To identify the functions available in Excel, click the Formulas tab on the Ribbon and then
click the Insert Function button in the Function Library group. Alternatively click the
button on the formula bar. Either approach provides the Insert Function dialog box shown
in Figure 6.
FIGURE 6 INSERT FUNCTION DIALOG BOX
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The Search for a function box at the top of the Insert Function dialog box enables us
to type a brief description of what we want to do. After doing so and clicking Go, Excel
will search for and display, in the Select a function box, the functions that may accomplish
our task. In many situations, however, we may want to browse through an entire category
of functions to see what is available. For this task, the Or select a category box is helpful.
It contains a drop-down list of several categories of functions provided by Excel. Figure 6
shows that we selected the Statistical category. As a result, Excel’s statistical functions appear in alphabetic order in the Select a function box. We see the AVEDEV function listed
first, followed by the AVERAGE function, and so on.
The AVEDEV function is highlighted in Figure 6, indicating it is the function currently
selected. The proper syntax for the function and a brief description of the function appear
below the Select a function box. We can scroll through the list in the Select a function box
to display the syntax and a brief description for each of the statistical functions that are
available. For instance, scrolling down farther, we select the COUNTIF function as shown
in Figure 7. Note that COUNTIF is now highlighted, and that immediately below the Select a function box we see COUNTIF(range,criteria), which indicates that the COUNTIF
function contains two arguments, range and criteria. In addition, we see that the description
of the COUNTIF function is “Counts the number of cells within a range that meet the given
condition.”
If the function selected (highlighted) is the one we want to use, we click OK; the
Function Arguments dialog box then appears. The Function Arguments dialog box for the
COUNTIF function is shown in Figure 8. This dialog box assists in creating the appropriate
FIGURE 7 DESCRIPTION OF THE COUNTIF FUNCTION IN THE INSERT FUNCTION
DIALOG BOX
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FIGURE 8 FUNCTION ARGUMENTS DIALOG BOX FOR THE COUNTIF FUNCTION

arguments for the function selected. When finished entering the arguments, we click OK;
Excel then inserts the function into a worksheet cell.

Inserting a Function into a Worksheet Cell
We will now show how to use the Insert Function and Function Arguments dialog boxes to
select a function, develop its arguments, and insert the function into a worksheet cell.
Suppose we want to construct a frequency distribution for the soft drink purchase data
in Table 1. Figure 9 displays an Excel worksheet containing the soft drink data and labels
for the frequency distribution we would like to construct. We see that the frequency of Coke
Classic purchases will go into cell D2, the frequency of Diet Coke purchases will go into
cell D3, and so on. Suppose we want to use the COUNTIF function to compute the
frequencies and would like some assistance from Excel.
Step 1: Select cell D2
Step 2: Click
on the formula bar
Step 3: When the Insert Function dialog box appears
Select Statistical in the Or select a category box
Select COUNTIF in the Select a function box
Click OK
Step 4: When the Function Arguments dialog box appear (see Figure 10)
Enter $A$2:$A$51 in the Range box
Enter C2 in the Criteria box (At this point, the value of the function will appear
on the next-to-last line of the dialog box. Its value is 19.)
Click OK
Step 5: Copy cell D2 to cells D3:D6
The worksheet then appears as in Figure 11. The formula worksheet is in the background; the value worksheet appears in the foreground. The formula worksheet shows that
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FIGURE 9 EXCEL WORKSHEET WITH SOFT DRINK DATA AND LABELS FOR
THE FREQUENCY DISTRIBUTION WE WOULD LIKE TO CONSTRUCT
A
1
2
3
4
5
6
7
8
9
10
45
46
47
48
49
50
51
52

C

D

Brand Purchased

B

Soft Drink

Frequency

Coke Classic
Diet Coke
Pepsi
Diet Coke
Coke Classic
Coke Classic
Dr. Pepper
Diet Coke
Pepsi
Pepsi
Pepsi
Pepsi
Coke Classic
Dr. Pepper
Pepsi
Sprite

Coke Classic
Diet Coke
Dr. Pepper
Pepsi-Cola
Sprite

E

F

FIGURE 10 COMPLETED FUNCTION ARGUMENTS DIALOG BOX FOR THE COUNTIF FUNCTION

the COUNTIF function was inserted into cells D2:D6. The value worksheet shows the
proper class frequencies as computed.
We illustrated the use of Excel’s capability to provide assistance in using the COUNTIF
function. The procedure is similar for all Excel functions. This capability is especially helpful if you do not know what function to use or forget the proper name and/or syntax for a
function.
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FIGURE 11 EXCEL WORKSHEET SHOWING THE USE OF EXCEL’S COUNTIF FUNCTION
TO CONSTRUCT A FREQUENCY DISTRIBUTION
A
1
2
3
4
5
6
7
8
9
10
45
46
47
48
49
50
51
52

B

C

D

E

Brand Purchased

Soft Drink

Frequency

Coke Classic
Diet Coke
Pepsi
Diet Coke
Coke Classic
Coke Classic
Dr. Pepper
Diet Coke
Pepsi
Pepsi
Pepsi
Pepsi
Coke Classic
Dr. Pepper
Pepsi
Sprite

Coke Classic
Diet Coke
Dr. Pepper
Pepsi-Cola
Sprite

COUNTIF($A$2:$A$51,C2)
COUNTIF($A$2:$A$51,C3)
COUNTIF($A$2:$A$51,C4)
COUNTIF($A$2:$A$51,C5)
COUNTIF($A$2:$A$51,C6)

A
1
2
3
4
5
6
7
8
9
10
45
46
47
48
49
50
51
52

C

D

Brand Purchased

B

Soft Drink

Frequency

E

Coke Classic
Diet Coke
Pepsi
Diet Coke
Coke Classic
Coke Classic
Dr. Pepper
Diet Coke
Pepsi
Pepsi
Pepsi
Pepsi
Coke Classic
Dr. Pepper
Pepsi
Sprite

Coke Classic
Diet Coke
Dr. Pepper
Pepsi-Cola
Sprite

19
8
5
13
5

USING EXCEL ADD-INS

Excel’s Data Analysis Add-In
Excel’s Data Analysis add-in, included with the basic Excel package, is a valuable tool for
conducting statistical analysis. Before you can use the Data Analysis add-in it must be installed. To see if the Data Analysis add-in has already been installed, click the Data tab on
the Ribbon. In the Analysis Group you should see the Data Analysis command. If you do
not have an Analysis Group and/or the Data Analysis Command does not appear in the
Analysis Group, you will need to install the Data Analysis Add-In. The steps needed to install the Data Analysis Add-In are as follows:
Step 1: Click the Office Button
Step 2: Click Excel Options (on the taskbar at the bottom)
Step 3: When the Excel Options dialog box appears:
Select Add-Ins from the list of options (on the pane on the left)
In the Manage box, select Excel Add-Ins (in the next to last row)
Click Go
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Step 4: When the Add-Ins dialog box appears:
Select Analysis ToolPak
Click OK

Outside Vendor Add-Ins
One of the leading companies in the development of Excel add-ins for statistical and decision analysis is Palisade Corporation. In the third edition of our text Modern Business
Statistics With Microsoft Excel, we use two Excel add-ins developed by Palisade: StatTools
and PrecisionTree. StatTools provides a powerful statistics toolset that enables users to perform statistical analysis in the familiar Microsoft Office environment. And PrecisionTree
enables users to quickly develop and analyze decision trees in an Excel framework.
In the appendix to Chapter 1 of Modern Business Statistics, 3rd edition, we illustrate
how to download and install the StatTools add-in and provide a brief introduction to using
the software. In several appendices throughout the text we show how StatTools can be used
when no corresponding basic Excel procedure is available or when additional statistical capabilities would be useful. The appendix to the decision analysis chapter of the text shows
how to install and use PrecisionTree.
Typically the add-ins offered with textbooks are designed primarily for classroom use.
StatTools and PrecisionTree, however, were developed for commercial applications. As a
result, students who learn how to use StatTools and PrecisionTree will be able to continue
using these products throughout their professional career.

